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Using the Painting Tools

The Painting Tools, gradient tools, Paint Bucket Tool, and Fill command let you change the color of pixels and create colored 
areas in an image.  You can select colors using the Color Palette, Swatches Palette, or Color Picker.

Painting involves changing the colors of pixels using a painting tool. You can apply colors gradually, with soft edges and 
transitions, and manipulate individual pixels using powerful filter effects.

To use the Brush or Pencil Tools - Photoshop provides 
the Brush tool and the Pencil tool to let you paint with the 
current foreground color.  By default, the Brush tool creates 
soft strokes of color and the Pencil tool creates hard-edged, 
free-hand lines.  However, you can change these default 
characteristics by resetting the tool’s brush options.  You can 
also use the Brush tool as an airbrush to apply sprays of 
color to an image.
1. Specify a freground color.
2. Select the Brush Tool or Pencil Tool.
3. Do the following in the options bar:

a) Choose a brush and set brush options.
b) Choose a bending mode from the Mode menu.
c) Specify an opacity by dragging the Opacity slider.
d) For the Brush Tool, specify a flow rate by dragging the Flow 
slider.
e) Click the Airbrush button to use as an airbrush.
f) For the Pencil Tool, select Auto Erase to paint the background 
color over areas containing the foreground color.

4. Do on or more of the following:
a) Drag in the image to paing.
b) To draw a straght line, click a starting point in the image, then 
hold down Shift, and click an ending point.
c) When using the Brush Tool as an airbrush, hold down the 
mouse button without dragging to build up color.

Working with Brushes - Working with brushes is an impor-
tant part of using the painting and editing tools.  The brush 
you select determines many characteristics of the resulting 
stroke.  Photoshop provides a variety of preset brushes to 
fill a wide range of uses.  In Photoshop, you can also create 
custom brushes using the Brushes Palette.

Using the Brushes Palette - The Brushes Palette lets you 
select preset brushes and design custom brushes.

To display the Brushes Palette, choose Brushes from the 
Window menu, or click the palette button on the right side of 
the Options Bar if you have a painting tool, erasing tool, ton-
ing tool, or focus tool selected.

To display options in the Brushes Pal-
ette, select an item name on the left 
side of the palette.  The options for the 
selected item appear ont he right side 
of the palette.

Selecting Preset Brushes 

1. Click a brush in the Brushes Palette.
2. Specify a diameter for the bursh by dragging the slider or enter-
ing a value. If the brush has a dual tip, both the primary and dual 
brush tips are scaled.
3. Click Use Sample Size to use the original diameter of the bursh 
tip.  (available only if the bruish tip shape is based on a sample.)

Customizing Brush Tips - You can customize brush tips 
by editing their options and create new brush tip shapes by 
sampling pixels in an image.  THe brush tip you select de-
termines the shape, diameter, and other characteristics of a 
brush mark.

1. Use any selection tool to select a part of an image to use as 
a custom brush.  Feather should be set to 0 pixels if you want to 
cerate a brush with a sharp edge. The brush shape can be up to 
2500 pixels by 2500 pixels in size.
2. Choose Define Brush Preset from the Edit menu.
3. Name the brush and click OK.

Selecting a Blending Mode - The blending mode speci-
fied in the options bar controls how pixels in the image are 
affected by a painting or editing tool.  It’s helpful to think 
in terms of the following colors when visualizing a blending 
mode’s effect:

a) The base color inthe original color in the image.
b) The blend color inthe color being applied with the painting or 
editing tool.
c) The result color is the color resulting from the blend.

Using the Eraser Tool - The Eraser Tool changes pixels in 
the image as you drag through them.  If you’re working in 
the background or in a layer with transparency locked, the 
pixels change to the background color; otherwise, the pixels 
are reased to transparency.  You can also use the earser 
to return the affected area to a state selected in the History 
Palette.

1. Select the Eraser Tool. 
2. Do the following in the Options Bar:

a) Choose a brush and set brush options. This option is not 
available for Block Mode.
b) Choose a mode fo the Eraser: Brush, Pencil, or Block.
c) Specify an opacity to define the strength of the erasure.  An 
opacity of 100% erases pixels completely. (Not available in 
Block Mode.)
d) In Brush Mode, specify a flow rate.
e) In Brush Mode, click the airbrush button to use the Brush as 
an airbrush.
f) To erase to a saved state or snapsot of the image, click the left 
column of the state or snapshot in the History Palette and then 
select Erase to History in the options bar.

3. Drag throught he area you want to erase.

Using the Magic Erase Tool - When you click in a layer 
with the Magic Eraser Tool, the tool automatically changes 
all similar pixels.  If you’re working in the background, orin 
a layer with locked transparency, the pixels change to the 
background color; otherwise, the pixels are earsed to trans-
parency.  You can choose to erase contiguous pixels only or 
all similar pixels onthe current layer.
1. Select the Magic Eraser Tool.

Setting Options for the Painting Tools
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2. Do the following in the Options Bar:
a) Enter a tolerance value to define the range of colors that 
can be erased. A low tolerance erases pixels within a range of 
color values very similar to teh pixel you click.  A high tolerance 
erases pixels within a broader range.
b) Select Anti-aliased to smooth the edges of the area you 
erase.
c) Select Contiguous to erase only pixels contiguous to the one 
you click, or deselect to erase all similar pixels in the image.
d) Select Use All Layers to sample the erased color using com-
bined data from all visible layers.
e) Specify an opacity to define the strength of the erasure.  An 
opacity of 100% erases pixels completely.

3. Click in the part of the layer you want to erase.

Using the Background Eraser Tool - The Background 
Eraser Tool lets you erase pixels on a layer to transparency 
as you drag; this allows you to erase the background while 
maintaining the edges of an object in the foreground.  By 
specifying different sampling and tolerance options, you can 
control the range of the transparency and the sharpness of 
the boundaries.

The background eraser samples the color in the center of 
the brush, also called the hot spot, and deletes that color 
wherever it appears inside the brush.  It also performs color 
extraction at the edges of any foreground objects, so that 
color halos are not visible if the foreground object is later 
pasted into another image.
1. In the Layers Palette, select the Layer containing the areas you 
want to erase.
2. Select the Background Eraser Tool.
3. Click the brush sample in the Options Bar and set brush options 
in the pop-up palette: Choose setting for the Diameter, Hardness, 
Spacing, Angle, and Roundness options.
4. Do the following in the Options Bar:

a) Choose a Limits Mode for erasing:  Dicontiguous to erase 
the sampled color wherever it occurs under the brush, Con-
tiguous to erase areas that contain the sampled color and are 
connected to one another, and Find Edges to erase connected 
areas containing the sampled color while better preserving the 
sharpness of shape edges. 
b) For Tolerance, enter a value or drag the slider. A low Toler-
ance limits erasure to areas that are very similar to the sampled 
color.
c) Select Protect Foreground Color to prevent the erasure of 
areas that match the foreground color in the toolbox.
d) Choose a Sampling option: Continuous to sample colors con-
tinuously as you drag, Once to erase only areas containing the 
color that you first click, and Background Swatch to erase only 
areas containing the current backgound color

5. Drag through the are you want to erase.

Using the Auto Erase Option - The Auto Erase option for 
the Pencil Tool lets you paint the background color over ar-
eas containing the foreground color.
1. Specify foreground and background colors.
2. Select the Pencil Tool.
3. Select Auto Erase in the Options Bar.
4. Drag over the image.

If the center of the cursor is over the foreground color when 
you begin dragging, the area is erased to the background 

color.  If the center of the cursor is over an area that doesn’t 
contain the foreground color when you begin dragging, the 
area is painted with the foreground color.

The Gradient Tool creates a gradual blend between multiple 
colors.  You can choose from preset gradient fills or create 
your own.

Applying a Gradient Fill - You fill an area with a gradient by 
dragging in the image.  The starting point and ending point 
affect the gradient appearance, depending on the Gradient 
Tool used.

1. To fill part of the image, select the desired area (otherwise, the 
gradient fill is applied to the entire active layer).
2. Select the Gradient Tool.
3. Choose a gradient fill in the Options Bar:

a) Click the triangle next to the gradient sample to pick a preset 
gradient fill.
b) Click inside the gradient sample to view the Gradient Editor.  
Select a preset gradient fill, or create a new gradient fill.  Then 
click OK.

4. Select an option for applying the gradient fill 
in the Options Bar:

a) Linear gradient to shade from the starting point to the ending 
point in a straight line.
b) Radial gradient to shade form the starting point to the ending 
point in a circular pattern.
c) Angle gradient to shade in a counter-clockwise sweep around 
the starting point.
d) Reflected gradient to shade using symmetric linear gradients 
on either side of the starting point.
e) Diamond gradient to shade from the starting point outward in 
a diamond pattern. The ending point defines one corner of the 
diamond.

5. Do the following in the Options Bar:
a) Specify a Blending Mode and Opacity for the paint.
b) To reverse the color order in the fill, select Reverse.
c) To create a smoother blend, select Dither.
d) To use a transparency mask, select Transparency.

6. Position the pointer in the image where you want to set the start-
ing point of the gradient, and drag to define the ending point.  To 
constrain the angle to a multiple of 45 degrees, hold down the shift 
key as you drag.

The Paint Bucket Tool fills adjacent pixels that are similar in 
color value to the pixels you click.
1. Specify a foreground color.
2. Select the Paint Bucket Tool.
3. Specify whether to fill the selection with the foreground color or 
with a pattern.
4. Specify a Blending Mode and Opacity for the paint.
5. Enter the Tolerance for the Fill.  Tolerance defines how similar in 
color a pixel must be to be filled.
6. To smooth the edges of the selection, select Anti-Aliased.
7. To Fill only pixels contiguous to the one you click, select Contigu-
ous; leave unselected to fill all similar pixels.
8. To Fill pixels based on the merged color data from all visible lay-
ers, select All Layers.
9. Click the part of the image you want to Fill.

Using the Gradient Tool

Using the Paint Bucket Tool
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You can fill a selection or layer with the foreground color, 
the background color, or a pattern.  You can also fill a shape 
using the Foreground Color, Gradient, or Pattern Overlay ef-
fects or the Solid Color, Gradient, or Pattern fill layers on the 
layers palette. 

To fill a selection or a layer 
1. Specify a foreground or background color.
2. Select the area you want to fill.
3. Choose Fill in the Edit menu, or Choose the Paint Bucket Tool 
from the Tool Box.
4. In the Fill dialog box, for Use, choose one of the following options 
or select a Custom Pattern:

a) Foreground Color, Background Color, Black, 50% Gray, or 
White to Fill the selection with the specified color.
b) Color to Fill with color selected from the Color Picker.
c) Pattern to Fill the selection with a pattern.  Click the inverted 
arrow next to the pattern sample and select a pattern from the 
pop-up palette.
d) History to restore the selected area to a state or snapshot of 
the image.

5. Specify the Blending Mode and Opacity for the paint.
6. If your’re working in a layer and want to fill only areas containing 
pixels, choose Preserve Transparency.
7. Click the OK button to apply the Fill.

Stroking a Selection or Layer - You can use the Stroke 
command to paint a colored border around a selection, lay-
er, or path.  If you want a quick way to create a Stroke on the 
current layer--without necessarily following the edge of the 
layer--use the Stroke command.
1. Specify a foreground color.
2. Select the area or layer you want to Stroke.
3. Choose Stroke in the Edit menu.
4. In the Stroke dialog box, specify the width of the border.
5. For Location, specify whether to place the border inside, outside, 
or centered over the selection or layer boundaries.
6. Specify an Opacity and a Blending Mode.
7. If you’re working in a layer and want to Stroke only areas con-
taining pixels, select the Preserve Transparency option.
A pattern is an image that is repeated, or tiled, during application. 
Photoshop comes with a variety of preset patterns. In Photoshop, 
you can create new patterns and save them in libraries for use with 
different tools and commands.

To define a preset pattern
1. Use the Rectangle Marquee Tool on any open image to select an 
area to use as a pattern.  Feather must be set to zero pixels.
2. Choose Define Pattern from the Edit menu.
3. Enter a name for the pattern in the Pattern Name dialog.

Photoshop uses the foreground color to paint, fill and stroke 
selections and the background color to make gradient fills 
and fill in the erased areas of an image. 

You can designate a new forground or background color us-
ing the Eyedropper Tool, the Color Palette, the Swatches 
Palette, or the Adobe Color Picker.

The default Foreground color is white and the default Back-
ground color is black.

The current Foreground color appears in the up-
per color selection box in the toolbox; the current 
Background color appears in the lower box.

Click the Switch Colors icon (double-headed arrow) in the 
toolbox to switch the Fore and Background colors.

Click the Defulat Colors icon (black and white squares) to 
restore the default colors to the Fore and Background.

Using the Eyedropper Tool - The Eyedropper Tool samples 
color to designate a new Foreground or Background color.  
You can sample from the active image, or from anywhere 
else on the screen.

You can also specify the area sampled by the Eyedropper 
Tool.  For example, you can set the Eyedropper to sample 
the color values of a 3x3 pixel area under the pointer.  Modi-
fying the sample size of the Eyedropper affects the color 
readouts displayed in the Info Palette.
1. Select the Eyedropper Tool.
2. To change the sample size of the Eyedropper, choose an option 
from the Sample Size menu.
3. To select a new Foreground color, click in the image.  Click and 
drag to see the color change dynamically.  To select a new Back-
ground color, Alt-click (win) or Option-click (mac) in the image.  
(Clicking and dragging will also dynamically change the color.)

Using the Color Palette - The Color Pal-
ette displays the color values for the cur-
rent Fore and Background colors. Using teh 
sliders in the Color Palette, you can edit the 
Fore and Background colors according to several different 
color models.
1. Click Color from the Window menu to display the Color Palette.
2. To change the color model of the sliders, choose a Sliders option 
from the Color Palette Menu.
3. To change the spectrum displayed in the color ramp, choose an 
option from the Color Palette Menu.

a) RGB, CMYK, and Grayscale display the spectrum of the 
specified model.
b) Current Colors displays the spectrum of colors between the 
current Fore and Background colors.

4. To edit the Fore or Background colors, make sure that its color 
selection box is active (outlined in black).  To make the Fore or 
Background color selection active, click the box, then drag the slid-
ers, or enter values next to the sliders.

Using the Swatches Palette - You can choose a Fore or 
Background color from the Swatches Palette.

Choose Swatches from the Window menu to display the 
Swatches Palette, or click the Swacthes tab next to the Col-
or tab if the Color Palette is already open.

Choose a display option from the Swatches Palette Menu: 
Small Thumbnail to display a small thumbnail of each 
swatch, or Small List to display the name and thumbnail of 
each swatch.

To choose a Foreground color, click a color 
in the Swatches Palette.  To choose a Back-
ground color, Ctrl-click (win) or Command-
click (mac) a color in the Swatches Palette.

Filling & Stroking Selections & Layers Creating and Managing Patterns

Choosing Fore and Background Colors



Transformations such as cropping, scaling, rotating, and dis-
torting, let you change the geometry of an entire image or 
parts of an image. Retouching lets you correct the tone and 
focus of an image, remove dust and scratches, and clone 
pixels within or between images.

Changing the Size of the Work Canvas - The Canvas Size 
command lets you add or remove work space around an 
existing image.  You can also use the command to crop an 
image by decreasing the canvas area.

Rotating and Flipping entire Images - The Rotate Canvas 
commands let you rotate or flip an entire image. The com-
mands do not work on individual layers or parts of layers, 
paths, or selection borders.

Choose Rotate Canvas from the Image menu and choose 
one of the following commands from sub-menu:

a) 180° to rotate by a half-turn.
b) 90° CW to rotate a quarter-turn clockwise.
c) 90° CCW to rotate a quarter-turn counter-clockwise.
d) Arbitrary to rotate the image by an angle you specify.
e) Flip Canvas Horizontal to flip along the vertical axis.
f) Flip Canvas Vertically to flip along the horizontal axis.

Cropping Images - Cropping is the process of removing 
portions of an image to create focus or stengthen the com-
position.  You can crop an image using the Crop Tool and 
Crop command.
1. Select the Crop Tool.
2. Drag over the part of teh image you want to keep to create a 
marquee.  Adjust the marquee by dragging it and/or grabbing the 
handles.
3. Press Enter (win) or Return (mac), click Commit in the Options 
Bar, or double-click inside the Crop area.

Tranforming Perspective while Cropping - The Crop Tool 
in Photoshop has an additional option that allows you to 
transform the perspective in an image. This is very useful 
when working with images that contain keystone distortion.

You can scale, rotate, skew, distort, and apply perspective to 
entire layers, selected parts of layers, masks, paths, shapes, 
selection borders, and channels.

Specify what to Transform
a) To transform an entire layer, make the layer active, with nothing 
selected.
b) To transform part of a layer, select the layer, and the select part 
of the image on the layer.
c) To transform multiple layers, link the layers together.
d) To transform a layer or vector mask, unlink the mask, and select 
the mask thumbnail in the Layers Palette.
e) To transform a selection border, make or load a selection.  Then 
choose Transform Selection from the Select menu.

Setting the Reference Point

All transformations are performed around a fixed point called 
the reference point.  By defuault, this point is at the center 
of the item you are transforming.  However, you can change 
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the reference point or move the venter point to a different lo-
cation using the reference point locator in the Options Bar.
1. Select a tranformation command - a bounding box appears in 
the image.
2. In the Options Bar, click on the reference point locator.  Each 
square represents a point on the bounding box. -or-
2. Drag the center point.  The center point can be outside the item 
you want to transform.

Applying Tranformations

The commands under the Transform sub-menu let you apply 
the following tranformations to an item:
a) Scaling enlarges or reduces relative to the reference point.
b) Rotating turns around the reference point.
c) Skewing lets you slant vertically or horizontally.
d) Distorting lets you stretch an item in all directions.
e) Applying perspective lets you apply one point perspective.

You can apply several commands in succession before ap-
plying the cumulative transformation.
1. Select what you want to Transform.
2. Choose Tranform > Scale, Rotate, Skew, Distort, or Perspective 
from the Edit menu.
3. In the Options Bar, click a Reference Point.
4. Do one of the following:

a) For Scale, drag a handle on the bounding box.  Hold Shift as 
you drag a corner handle to scale proportionally.
b) For Rotate, move the pointer outside the bounding border, 
then drag.  Hold Shift to contrain to 15° increments.
c) For Skew, drag a side handle to slant the bounding box.
d) For Distort, drag a corner handle to stretch the bound box.
e) For Perspective, drag a corner handle to apply perspective to 
the bounding box.

5. If desired, switch to a different type of transformation by choosing 
another item from the Transform sub-menu.
6. When you’re finished press Enter (win) or Return (mac). 

Using the Free Transform Command

The Free Tranform command lets you apply transformations 
in one continuous operation.
1. Select what you want to Transform.
2. Choose Free Transform from the Edit menu.
3. In the Options Bar, click a Reference Point.
4. Do one of the following:

a) To Scale, drag a handle on the bounding box.  Hold Shift as 
you drag a corner handle to scale proportionally.
b) To Rotate, move the pointer outside the bounding border, 
then drag.  Hold Shift to contrain to 15° increments.
c) To Distort relative to the center point, press Alt (win) or Option 
(mac) and drag a handle.
d) To Distort freely, press Ctrl (win) or Command (mac) and drag 
a handle.
e) To Skew, press Ctrl-Shift (win) or Command-Shift (mac) and 
drag a side handle.
f) To apply Perspective, press Ctrl-Alt-Shift (win) or Command-
Option-Shift (mac) and drag a corner handle.
g) To move an item, enter values for the new location of the 
reference in the X and Y text boxes in teh Options Bar.  Click the 
Relative Positioning button to specify the new position in relation 
to the current position.

5. When you’re finished press Enter (win) or Return (mac). 

Tranforming Objects

Image Operations
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The Clone Stamp Tool takes a sample of an image, which 
can then apply over another imate or part of the same im-
age.  You can also clone part of one layer over another layer.  
Each stroke of the tool paints on more of the sample.
1. Select the Clone Stamp Tool.
2. Choose a brush tip and set brush options for the blending mode, 
opacity, and flow in the Options Bar.
3. Select Aligned in the Options Bar to sample pixels continuously, 
without losing the curent sampling point, even if you release the 
mouse button.  Deselect Aligned to continue to use the sampled 
pixels from the initial sampling point each time you stop and re-
sume painting.
4. Select Use All Layers in the Options Bar to sample data from all 
visible Layers.
5. Set the sampling point by positioning the point in any open image 
and Alt-clicking (win) or Option-clicking (mac).
6. Drag over the area of the image you want to correct.

The Pattern Stamp Tool lets you paint with a patern.  You can 
select a pattern from the pattern libraries or create your own 
patterns.
1. Select the Pattern Stamp Tool.
2. Choose a brush tip and set brush options for the blending mode, 
opacity, and flow in the Options Bar.
3. Select Aligned in the Options Bar to sample pixels continuously, 
without losing the curent sampling point, even if you release the 
mouse button.  Deselect Aligned to continue to use the sampled 
pixels from teh initial sampling point each time you stop and re-
sume painting.
4. Select a Pattern from the pattern palette in the Options Bar.
5. Select Impressionist to apply the pattern with that effect.
6. Drag in the image to paint with the pattern.

The Healing Brush Tool lets you correct imperfections, caus-
ing them to disappear into the surrounding image. Like the 
cloning tools, you use the Healing Brush Tool to paint with 
sampled pixels from an image or pattern. However, the Heal-
ing Brush Tool also matches the texture, lighting, transpar-
ency, and shading of the sampled pixels to the source pixels.  
As a result, the repaired pixels blend seamlessly into the rest 
of the image.
1. Select the Healing Brush Tool.
2. Click the brush sample in the Options Bar and set brush options 
for the pop-up palette.
3. Choose a Blending Mode from the Mode pop-up menu in the 
Options Bar.  Choose Replace to preserve noise, film grain, and 
texture at the edges of the brush stroke. 
4. Choose a source to use for repairing pixels in the Options Bar: 
Sampled to use pixels from the current image, or Pattern to use 
pixels from a pattern.  If you chose Pattern, select a pattern from 
the Pattern pop-up palette.
5. Select Aligned in the Options Bar to sample pixels continuously, 
without losing the curent sampling point, even if you release the 
mouse button.  Deselect Aligned to continue to use the sampled 
pixels from the initial sampling point each time you stop and re-
sume painting.

6. Select User All Layers in the Options Bar to sample data from all 
visible Layers.
7. For the Healing Brush Tool in sampling mode, set the sampling 
point by positioning the pointer in any open image and Alt-clicking 
(win) or Option-clicking (mac).
8. Drag in the image.  The sampled pixels are melded with the ex-
isting pixels each time you release the mouse button. Look in the 
status bar to view the status of the melding process.

The Patch Tool lets you repair a selected area with pixels 
from another area or a pattern.  Like the Healing Brush Tool, 
the Patch Tool matches the texture, ligthing and shading of 
the sampled pixels to the source pixels.  You can also use 
the Patch Tool to clone isolated areas of an image.
1. Select the Patch Tool.
2. Drag in the image to select teh area you want to repair, and se-
lect Source in the Option Bar. -or- Drag in the image to select the 
the area from which you want to sample, and select Destination in 
the Options Bar.
3. Position the pointer inside the selection, and if Source is selected 
in the Options Bar, drag the selection border tothe area from which 
you want to sample.  When you release the mouse button, the origi-
nally selected area is patched with the sampled pixels. -or- If Des-
tination is selected in the Options bar, drag the selection border to 
teh area you want to patch.  When you release the mouse button, 
the newly selected area is patched with the sampled pixels.

The Color Replacement Tool simplifies replacing specific 
colors in your image.  You can paint over a targeted color 
-- for example, a person’s red eyes in an image -- with a cor-
rective color.
1. Select the Color Replacement Tool.
2. Choose a brush tip in the Options Bar.
3. For the Sampling option, choose one of the following:

a) Continuous to sample colors continuously as you drag.
b) Once to replace the targeted color only in areas containing 
the color that you first click.
c) Background Swatch to erase only areas containing the cur-
rent background color.

4. For the Limits option, select one of the following:

a) Discontiguous to replace the sampled color wherever it oc-
curs under the pointer.
b) Contiguous to replace colors that are contiguous with the 
color immediately under the cursor.
c) Find Edges to replace connected areas containing the sam-
pled color while preserving the sharpness of shape edges.

5. For tolerance, enter a value (0-255) or drag the slider.
6. To define a smooth edge to your corrections, select anti-aliased.
7. Choose a foreground color to replace the unwanted color.
8. Click the color you want to replace in the image.
9. Drag in the image to replace the targeted color.

Clone Stamp Tool

Healing Brush Tool

Color Replacement Tool

Patch Tool

Pattern Stamp Tool



Smudge Tool - The Smudge tool simulates the actions of 
dragging a finger through wet paint.  The tool picks up color 
where the stroke begins and pushes it in the direction you 
drag.
1. Select the Smudge Tool.
2. Choose a brush tip and Blending Mode in the Options Bar.
3. Select User All Layers in the Options Bar to smudge using color 
data from all visible layers.
4. Select Finger Painting in the Options Bar to smudge using the 
foreground color at the beginning of each stroke.
5. Drag in the image to smudge the pixels.

Blur Tool - The Blur tool softens hard edges or areas in an 
image to reduce detail.
1. Select the Blur Tool.
2. Choose a brush tip and set Options for the blending mode and 
strength in the Options Bar.
3. Select User All Layers in the Options Bar to smudge using color 
data from all visible layers.
4. Drag in the image to blur the pixels.

Sharpen Tool - The Sharpen tool focuses soft edges to in-
crease clarity or focus.
1. Select the Sharpen Tool.
2. Choose a brush tip and set Options for the blending mode and 
strength in the Options Bar.
3. Select User All Layers in the Options Bar to smudge using color 
data from all visible layers.
4. Drag in the image to sharpen the pixels.

Used to lighten or darken areas of the image, the Dodge 
tool and the Burn Tools are based on a traditional photogra-
pher’s technique for regulating exposure on specific areas of 
a print.  Photographers hold back light to lighten an area of 
the print (dodging) or increase the exposure to darken areas 
on a print (burning).

Dodge & Burn Tools 
1. Select the Dodge Tool            or the Burn Tool.
2. Choose a brush tip and set brush options in the Options Bar.
3. Select one of the following in the Options Bar:

a) Midtones to change the middle range of grays.
b) Shadows to change the dark areas.
c) Highlights to change the light areas.

4. Specify the exposure for the Dodge Tool or the Burn Tool.
5. Click the airbrush button to user the brush as an airbrush.
6. Drag over the part of the image you want to lighten or darken.

Sponge Tool 
1. Select the Sponge Tool.
2. Choose a brush tip and set brush options in the Options Bar.
3. Select one of the following in the Options Bar:

a) Saturate to intensify the color’s saturation.
b) Desaturate to dilute the color’s saturation.

4. Specify the flow for the Sponge Tool.
6. Drag over the part of the image you want to modify.
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Dodge, & Burn, & Sponge  Tools

Smudge, Blur, & Sharpen Tools



Each image in Adobe Photoshop has channels that store in-
formation about the image’s color.  Channels are grayscale 
images that store different types of information:

Color Information Channels - are created automatically 
when you open a new image.  The image’s color mode de-
termines the number of color channels created.  For exam-
ple, an RGB image has four default channels: one for each 
of the red, green, and blue colors, plus a composite channel 
used for editing the image.

Alpha Channels - You use alpha channels to create and 
store masks, which let you manipulate, isolate, and protect 
specific parts of an image.

The Channels Palette - The Channels 
Palette lets you create and manage chan-
nels and monitor the effects of editing. 
The Palette lists all channels in the image  
composite channel first (for RGB, CMYK, and LAB imag-
es), then individual color channels and alpha channels.  A 
thumbnail of the channel’s contents appears to the left of the 
channel name; the thumbnail automatically updates as you 
edit the channel.

You can use the palette to view any combination of individual 
channels.  For example, you can view an alpha channel and 
the composite chanel together to see how changes made in 
the alpha channel relate to the entire image.

Choose Channels in the Window menu to show or hide the 
Channels Palette.  Click in the eye column next to the chan-
nel to show or hide that channel.

a) If more than one channel is selected, the channels always 
appear in color.
b) In alpha channels, selected pixels appear as white; unselect-
ed pixels appear as black.
c) If you display an alpha channel at the same time as color 
channels, the alpha channel appears as a translucent color 
overlay, analogous to a printer’s rubylith or a sheet of acetate.

You can select one or more channels in the Channels Pal-
ette. The names of all  active channels are highlighted.  Any 
editing changes you make apply to the active channels.

Use a painting or editing tool to paint in the image. Paint with 
white to add the selected channel’s color at 100% intensity. 
Paint with a value of gray to add teh channel’s color at a 
lower intensity. Paint with black to fully remove the channel’s 
color.

Managing Channels - You can rearrange channels, dupli-
cate a channel within or between images, split a channel 
into separate images, merge channels from separate im-
ages into one new image, and delete alpha channels when 
you are finished with them.

You cannot move or rename the default channels at the 
top of the palette, but you can rearrange and rename alpha 
channels to suit the way you work. Drag the channel up or 
down to change the order of alpha channels.  Double-click 
the channel’s name in the Channels Palette, and enter a 
new name.
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Duplicating Channels - You might duplicate an image’s 
channel to make a backup before editing the channel.  Or 
you might duplicate alpha channels to a new image to cre-
ate a library of selections to load into the current iamge one 
by one, thus keeping the file smaller.
1. In the Channels Palette, select the channel to duplicate.
2. Choose Duplicate Channel from the Channels Palette Menu.
3. Type a name for the duplicate channel.
4. For Document, choose a destination.  To duplicate the channel 
in the same file, select the channel’s current file. -or- Choose New 
to copy the channel to a new image, creating a multichannel image 
containing a single channel.  Type a name for the new image.
5. To reverse the selected and masked areas inteh duplicate chan-
nel, select Invert.

Splitting Channels - You can split the channels of a flat-
tened image into separate images.  The original file is closed, 
and the individual channels appear in separate grayscale 
iamge windows. The title bars in the new windows show the 
original file name plus the channel abbreviation (win) or full 
name (mac).  Any changes since the last save are retained 
in the new images and lost in the original.  Choose Split 
Channels from the Channels Palette Menu to split the chan-
nels into separate images.

Merging Channels - Multiple grayscale images can be 
combined into a single image.  Merging lets you combine 
separate grayscale images into a single color image.

The images you want to merge must be in Grayscale mode, 
have the same pixel dimensions, and be open. The number 
of grayscale images you have open determines the color 
modes available when merging channels.  For example, you 
can’t merge the split channels from an RGB image into a 
CMYK image, because CMYK requires four channels and 
RGB requires only three.
1. Open the grayscale images containing the channels you want to 
merge, and make one of them active.
2. Choose Merge Channels from the Channels Palette Menu.
3. For Mode, choose the color mode you want to create.
4. If necessary enter a number in the Channels text box.
5. Click OK.
6. For each channel, make sure the image you want is open.  If you 
change your mind about image type, click Mode to return to the 
Merge Channels dialog box.
7. If merging into a multichannel image, click Next and repeate step 
6 to select the remaining channels.
8. When you are finished selected channels, click OK.

The selected channels are merged into a new image of the 
specified type, and the original images are closed without 
any changes.

Deleting Channels - You may want to delete an alpha chan-
nel you no longer need before saving an image.  Complex 
alpha channels can substantially increase the disk space 
required for an image.

1. Select the channel in the Channels Palette.
2. Drag the channel in the Palette to the Trash Button.  -or- Click 
the Trash button at the bottom of the palette, then click Yes.  -or-  
Choose Delete Channel from the Channels Palette Menu.


